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Introduction

Atmel® SAM Boot Assistant (Atmel SAM-BA)® allows In-system
Programming (ISP) using USB or UART host without any external
programming interface. In general, Atmel SAM-BA monitor is factory
programmed in the available ROM memory, in SAM3 and SAM4 series
devices. Since there is no ROM memory in SAM L series devices such as
SAM L21 and SAM L22, the SAM-BA monitor is not factory programmed. To
support SAM Boot Assistant in SAM L series devices, SAM-BA bootloader
can be loaded in Flash memory.

This application note complements the SAM-BA user guide and explains
usage of the SAM-BA on SAM L series devices.

Features

*  Allows to program, verify, and secure an Atmel SAM L21/SAM L22
device without debugger

+ USB and UART connection

+  Allows the end user to update application firmware from bootloader
»  Configurable I/O start condition

»  Customizable Source code available

*  Compatible with SAM-BA v2.16 or later

Atmel-42650A-SAM-BA-Bootloader-for-SAM-L-Series-Devices_AT10840_Application Note-04/2016




Table of Contents

INEFOAUCTION. ... 1
FALUIES. ..., 1
1. ReQUINEMENES. ..o 3
1.1, Hardware REQUIEMENTS.........c.uiiiiiiii ettt 3

1.2, SOftWare REQUITEMENES. .........uviiiiii et e e e e e e s et e e e e e e satreeaeesnsreeeaeeenes 4
1.2.1.  Application Constraints............ooiiiiiiiiiiiiiic e e 4

2. Using the BOOHOAAET ...........cooiiiiiiecce e 7
2.1, Programming the BOOHOAAET .............uuiiiiiiiiiiie ettt et e e et e e e s e e e e e e ennnes 7

2.2,  Entering the BOOUOAET .........coooieiiiiiii et 8

2.3. Selecting the Communication INterface.............ccouiiiiiiiiiiiie e 8

2.4. Using the Bootloader with SAM-BA GUI..........cooiiiiiiiiiiii e 8
2.4.1.  Connecting from SAM-BA PC Application...........ccccoiiiiiiiiieiiiie e 8

P R o - 11 o I o 7= o [ T R PP PRPPN 9

A B TS Tor o] (=T PSPPSR RUPPOPRR 9

3. Re-building SAM-BA MONITOT........cooiiiiiiiiieee e 10
4. REfEIENCES. ..o 11
5. REVISION HISTOMY.....oiiiiiiiiiii e e e e e 12

Atmel

Atmel AT10840: SAM-BA Bootloader for SAM L Series Devices [APPLICATION NOTE]
Atmel-42650A-SAM-BA-Bootloader-for-SAM-L-Series-Devices_AT10840_Application Note-04/2016

2



Requirements

1.1. Hardware Requirements
The Atmel SAM L21/L22 SAM Boot Assistant (SAM-BA) supports serial communication through UART or
USB device port.
Table 1-1. UART Mode Requirements - ATSAM L22N18A
PC25 Connect to host (115200, 8, N, 1) SERCOM4 PAD3 (UART RXD)
PC24 Connect to host (115200, 8, N, 1) SERCOM4 PAD2 (UART TXD)
Table 1-2. USB Mode Requirements - ATSAML22N18A
PA25 Connect to host USB D+ pin
PA24 Connect to host USB D- pin
Table 1-3. Hardware Bootloader Entry - ATSAML22N18A
Name Connection
PCO1 Connect to host or The bootloader will check PC01 on reset to determine if the
“Bootloader access switch” | bootloader monitor shall start. This feature allows the end
user to reprogram the device even if the application is
corrupted or unable to start the SAM-BA monitor.
Table 1-4. UART Mode Requirements - ATSAML21J18B
PA23 Connect to host (115200, 8, N, 1) SERCOMS3 PAD1 (UART RXD)
PA22 Connect to host (115200, 8, N, 1) SERCOMS3 PADO (UART TXD)
Table 1-5. USB Mode Requirements - ATSAML21J18B
PA25 Connect to host USB D+ pin
PA24 Connect to host USB D- pin
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Table 1-6. Hardware Bootloader Entry - ATSAML21J18B

PAO2 Connect to host or The bootloader will check PA02 on reset to determine if the
“Bootloader access switch” | bootloader monitor shall start. This feature allows the end
user to reprogram the device even if the application is
corrupted or unable to start the SAM-BA monitor.

Software Requirements

Application Constraints

The SAM-BA bootloader in SAM L21/L22 is stored in flash memory at 0x00000000 and started on reset.
For SAM-BA with only UART interface enabled, bootloader is stored in flash memory from 0x0000 —
0x2000 (8KB). For SAM-BA with both USB and UART interfaces enabled, bootloader is stored in flash
region 0x0000 — 0x6000 (24KB).

SAM-BA bootloader is not factory programmed on SAM L series devices and has to be programmed
using an external programmer. Since SAM-BA is stored in flash memory, if the application requires the
entire flash space and does not need the bootloading feature, SAM-BA can be erased using external
programmer.

To use SAM-BA together with an application, the user must link the application starting at 0x2000 when
UART interface is alone enabled and at 0x6000 when both USB and UART interfaces are enabled.

The procedure to modify the start address in an IAR project and an Atmel Studio project is explained in
Atmel AT04189: UART Based SAM-BA Bootloader for SAM D20.

AtmeL Atmel AT10840: SAM-BA Bootloader for SAM L Series Devices [APPLICATION NOTE]

Atmel-42650A-SAM-BA-Bootloader-for-SAM-L-Series-Devices_AT10840_Application Note-04/2016

Signal Recommended Pin Description
Name Connection

4


http://www.atmel.com/images/atmel-42238-uart-based-sam-ba-bootloader-for-sam-d20_ap-note_at04189.pdf

Figure 1-1. Memory Map of ATSAML21J18B / ATSAML22N18A with an Application and SAM-BA with both
USB and UART

MCU flash
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Figure 1-2. Memory Map of ATSAML21J18B / ATSAML22N18A with an Application and SAM-BA with UART
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When loading the application's binary image to the device, the part of flash after the SAM-BA must be

used for programmed.

Any attempt to write into the SAM-BA region using SAM-BA commands will be aborted and will generate

an error.
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Using the Bootloader

21. Programming the Bootloader
Available Bootloader Projects for SAM L Series devices
SAM L21:
Launch Atmel Studio -> File -> New -> Example Project... -> SAM0 SAM-BA Bootloader Example - SAM
L21 Xplained Pro (ATSAML21J18B)
SAM L22:
Launch Atmel Studio -> File -> New -> Example Project... -> SAM0 SAM-BA Bootloader Example - SAM
L22 Xplained Pro
Build the Example Project and program the Atmel SAM Boot Assistant using SWD debugger:
1. In Atmel Studio application, open Tools > Device Programming, select the Tool, and click Apply.
2. From the Memories tab, erase the chip by clicking Erase now.
3. Specify the path for SAM-BA image in the Flash box and Program.
Figure 2-1. Device Programming - SAML22 device
[epsa (ATMLZS4?U2GZW [
Tool Device Interface Device signature Target Voltage
ATSAML22NISA v 0x10820000 33V 3
Interface settings !Jevice
Tool information IEraseChip vl I Erase now l
Device information Flash (264 KE]
: A DASAMBA_BOOT_SAML2Z_XPRO\Debug\SAMBA_BOOT_SAML22_XPRO.hex
Erase Flash before programmin ( ( 5
brses Werify Flash after plrjog?ammingg Program ] l erify
Security v ) Advanced
l User Page (256 bytes)
I Erase User Page before programming
Werify User Page after programming
| Advanced
Erasing device... OK
Programming Flash...OK
Verifying Flash..OK
B Verifying Flash...OK
Alternately, command-line programming tool atprogram can also be used for programming the hex file.
Example Command: atprogram —t edbg —i swd —d atsaml22n18a program —f
SAMBA_BOOT_SAML22 _XPRO.hex
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Note: The same steps must be followed to program SAM-BA Bootloader for SAML21 series devices

2.2. Entering the Bootloader
The SAM L21/ L22 SAM-BA relies on a SAM-BA bootloader which is stored in flash memory. This monitor
will be executed according conditions specified in the boot process.
SAM-BA bootloader activation can be requested using one of the following ways:

+  External condition: Reset the part and make sure the Hardware Bootloader Entry pin (PC01 for
SAM L22 & PAO2 for SAM L21) is pulled low, when reset is released. A common usage is to use a
push button accessible by the user as a bootloader trigger. The user must simply hold the push
button when powering up the device.

+ Internal condition: On erased devices or when the application reset vector (@Application start
address + 4) is blank (OXFFFFFFFF).

2.3. Selecting the Communication Interface
The SAM-BA bootloader can be compiled by commenting #define
CONF_USB CDC_INTERFACE SUPPORT in conf board.h file in the Atmel Studio project. By default,
project supports both interfaces (USB, UART)
24. Using the Bootloader with SAM-BA GUI
2.41. Connecting from SAM-BA PC Application
For using SAM-BA monitor with UART interface, connect SAM L22 Xplained Pro to the PC via DEBUG
USB port using the micro-USB cable as the UART pins are connected to it.
Figure 2-2. Connecting from SAM-BA PC Application using UART
475" Ports (COM & LPT) 'S 3
? Communications Port (COM1) F AR 2T E@ﬂ
7' ECP Printer Port (LPT1) o <] J-LinkInterface
? EDEG Virtual COM Port (COM4L) Select the connection : |[COM41 : i J(I.; J:':; i
o I} Processors Select your board : |saml22_xplained_pro |~
b j Smart card readers ILink TimecutMultiplier: |0 hd = SWD
:> -% Sound, video and game controllers [ Customize lowlevel
b &; Storage controllers
> -JM| System devices — :
b- i U)l;i\.rersal Serial Bus controllers i :l Bt
For using SAM-BA monitor with USB interface, connect SAM L22 Xplained Pro to the PC via TARGET
USB port using the micro-USB cable.
Figure 2-3. Connecting from SAM-BA PC Application using USB CDC
475" Ports (COM & LPT) s 3
| 13" ATSL USB to Serial Converter (COMi2) | L SAM-BA 216 Lo | & e
:3 ECDI:”I;:::;EI:LTEL?FT](COMD Select the connection : \USBserial\C.OMélE |~/ J;I;:injlf.r?;erface
o I} Processors Select your board : |saml22_xplained_pro |~
b j Smart card readers ILink TimecutMultiplier: |0 hd = SWD
:> -% Sound, video and game controllers [ Customize lowlevel
b &; Storage controllers
> -JM| System devices — :
b- i U)l;i\.rersal Serial Bus controllers |l :l Bt
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2.4.2.

Flash Loading

The contents of the Flash are loaded using the Flash tab. While uploading a program to flash memory,
the start address must be 0x2000 when using UART and 0x6000 when using both USB and UART,
otherwise the transfer process will be aborted.

Figure 2-4. Flash Programming

-
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0x100 bytes written by applet
Writing: 0x100 bytes at 0x2700 (buffer addr : 0x20000E78)
0x100 bytes written by applet
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0xCC bytes written by applet

ba_2.16_rc6) 2 %
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Note: The same steps can be followed for SAM L21 series devices.

243. Scripts

The following predefined scripts are available with the Atmel SAM-BA application.

Table 2-1. Predefined Scripts

Sapilew [P ]

Set Security Bit

Read Security Bit
Erase application area
Invalidate application

Read Fuses

Read Lock Fuses
Read DevicelD
Set Lock Bit [0:15]

Unlock all

Atmel
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Set the security bit to secure the device. Refer to NVMCTRL chapter in the
device datasheet for more information.

Read the current security state
Erase all application code (SAM-BA monitor region will not be erased)
Erase first page of application

Returns the values of fuse settings. Refer to NVM user row mapping section in
the device datasheet for more information.

Read the current lock settings
Read the Device ldentification register

Set the specified lock bit to prevent any erasure of flash memory region. Refer
to the NVMCTRL chapter in the device datasheet for more information.

Unlock all flash memory regions
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Re-building SAM-BA Monitor
The following pins are used by the SAM-BA bootloader for ATSAML22N18A (100 pin count) device.

Table 3-1. Pins Used in ATSAML22N18A

T

PA25 USB D+

PA24 USB D-

PC25 UART RxD (SERCOM4 PAD3)

PC24 UART TxD (SERCOM4 PAD2)

PCO1 General Purpose Input (Hardware Bootloader Entry pin)

The USB pins (PA24, PA25) are same in all the SAM L22 device variants.

While building the project for other SAM L22 devices, the general purpose input pin, SERCOM pins
(UART RxD, UART TxD) must be changed based on the respective SAM L22 device’s pinout.

To change the pin mapping, edit the conf bootloader.h file in the SAM-BA bootloader project.
For other SAM L22 device variants, the project has to be recompiled by changing the device.

The following pins are used by the SAM-BA bootloader for ATSAML21J18B (64 pin count) device.
Table 3-2. Pins Used in ATSAML21J18B

T

PA25 USB D+

PA24 USB D-

PA23 UART RxD (SERCOM3 PAD1)

PA22 UART TxD (SERCOM3 PADO)

PAO2 General Purpose Input (Hardware Bootloader Entry pin)

While building the project for other SAM L21 devices, the general purpose input pin, SERCOM pins
(UART RxD, UART TxD) must be changed based on the respective SAM L21 device’s pinout.

To change the pin mapping, edit the conf bootloader.h file in the SAM-BA bootloader project.
For other SAM L21 device variants, the project has to be recompiled by changing the device.

Note: 1. For SAML21 series devices: SAM-BA bootloader is supported only from Rev B or later version of
devices.

2. For SAM L21 series devices: There is no USB interface supported in ASF3.30. This support will
be added in the subsequent ASF release.
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4. References

1.

2.
3.
4

Atmel

Device Datasheet: http://www.atmel.com/Images/Atmel-42402-SAM-L22_Datasheet.pdf.
Device Datasheet: http://www.atmel.com/Images/Atmel-42385-SAM-L21_Datasheet.pdf.
Atmel SAM-BA User Guide in SAM-BA installation folder in the PC.
ARM® documentation on Cortex®-M0+ Core:

—  Cortex-M0+ Devices Generic User Guide revision rOp1

—  Cortex-M0+ Technical Reference Manual revision rOp1
Atmel SAM-BA In-system Programmer: http://www.atmel.com/tools/atmelsam-bain-
systemprogrammer.aspx.
Atmel Studio: http://www.atmel.com/tools/ATMELSTUDIO.aspx.
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5. Revision History

Comments

42650A 04/2016 Initial document release.
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